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Welcome!

Your EPSON Stylus® C60 is the ideal printer for personal or home office use. With 
resolutions up to 2880 by 720 dpi, you can print anything from reports and resumes 
to family photos and greeting cards.

About Your Software

The CD-ROM that came with your printer includes all the software you need for 
printing. (You must have a CD-ROM or DVD drive installed in your computer.) See 
the Start Here sheet for installation instructions.

� Your printer driver runs your printer and lets you control how your documents 
look. You can’t print without it. 

� Your EPSON® Print Show movies are animated tutorials on loading special 
paper, replacing ink cartridges, improving print quality, and other basic tasks. 

� Your on-screen Reference Guide gives you complete information about your 
printer. (You need a browser—such as Microsoft® Internet Explorer or Netscape® 
Navigator,® version 3.0 or later—to view the guide.)

� EPSON Software™ Film Factory™ Lite is a photo management 
program that lets you organize, beautify, and print your photos 
in a flash (optional). 

It’s a good idea to check EPSON’s support web site 
periodically for free updates to your printer driver. Visit 
http://support.epson.com. Download instructions are posted for your 
convenience.
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About Your Documentation

To set up your printer and install its software, see the Start Here sheet. This book 
contains system requirements, important safety information, and instructions on:

� Viewing your EPSON Print Show movies and Reference Guide 

� Printing with Windows® or on a Macintosh® 

� Maintaining the printer

� Solving basic problems

For more details about printing with, maintaining, or troubleshooting your printer, 
see your Print Show movies and Reference Guide, as described on page 3. 

Warnings, Cautions, Notes, and Tips

Please follow these guidelines:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for better printing.
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Installing Your EPSON Print Show Movies and 
Reference Guide

Need help loading special paper, replacing ink cartridges, or cleaning the print head? 
Your printer CD-ROM includes animated printer movies and an on-screen Reference 
Guide. 

You need a browser—such as Microsoft Internet Explorer 3.0 or later or Netscape 
Navigator 3.0 or later—to view the Reference Guide. If you are using a different 
browser, the pages may not display correctly. (A browser is not included on the 
printer CD-ROM.)

Once you install the movies and manual, you can view them whenever you want. 
Follow these steps to install them:

1. Insert your printer CD-ROM.

2. Do one of the following:

Windows: (If you’re using 
Windows XP, first click start.) 
Double-click My Computer, 
double-click your  CD-ROM or 
DVD drive icon, then double-click 
the  EPSON icon. 

Macintosh: Double-click the
 EPSON icon in the CD-ROM 

window. (If the folder doesn’t open, 
first double-click your EPSON 
CD-ROM icon.) 

The Main Menu appears:

3. Click Install Printer Movies and Manual. 

4. Click Install.
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Viewing Your EPSON Print Show Movies and 
Reference Guide

1. Once your printer movies and 
reference guide are installed, 
simply double-click the EPSON 
Printer Information Center icon 
on your desktop to launch the 
movies and manual. You see 
this screen:

2. Click Print Show or Reference 
Guide.

If you click Print Show, you see 
this menu:

3. Click the topic you want. You 
see another menu listing the 
individual Print Show movies. 

4. Click the movie you want to 
watch. 
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The movie opens and plays automatically on your screen:

As you watch the movie, you can turn the narration off, pause, replay a step, or 
skip ahead. 

When you open the Reference Guide, you see this screen:

Click a topic on the left to expand the table of contents. After expanding the table of 
contents, you can click on the topic you want to view.

Exit the EPSON Printer 
Information Center

Go back to 
the menu

Turn off the 
narration

Replay the 
last step

Pause the 
movie

Click here 
to expand 
the table of 
contents
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� If there’s a right arrow , click it to view subtopics, then click on a topic to go to 
it.

� Click the down arrow to close a subtopic list.

If you see an icon for a graphic when viewing your Reference Guide in 
Netscape Navigator, click the Reload button to load the graphic.

Closed list, 
click to 
expand

Click to go 
to topic
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Printing From Start to Finish

Before you start, make sure your printer software is installed as described on the Start 
Here sheet.

No matter what you print, you need to remember two things:

� Use the right paper.
For the best-looking photos, most vivid colors, and sharpest text, always use 
EPSON ink jet papers. 

� Choose the right printer settings.
Your printer automatically adjusts itself for each type of paper. That’s why printer 
settings are important. They tell your printer what kind of paper you’re using. So 
remember to check your printer settings every time you print. 

Follow the instructions in these sections:

� Loading Paper on page 8

� Basic Printing in Windows on page 10

� Basic Printing on a Macintosh on page 14

� Customizing Your Print Settings on page 16

� Selecting the Correct Media Type on page 18

� Printing Photos on page 19
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Loading Paper

Make sure your printer and computer are turned on.

1. Place your paper against the right edge of the sheet feeder, behind the tab.

2. Press in the locking tab on the left edge guide and slide it against the paper. 

3. Pull out the output tray extension.

Follow these guidelines when loading paper:

� Always load the short edge first, even when you’re printing landscape oriented 
documents.

� Load the printable side face up. It’s usually whiter or brighter than the other side.

� Load letterhead or preprinted paper into the printer top edge first.

� Don’t load paper above the arrow on the left edge guide.

See your Print Show movies for instructions on loading various types of paper. 
Double-click the EPSON Printer Information Center icon on your desktop.

Load paper 
behind the tab

Press the locking 
tab and slide the 
left edge guide 
against the paper
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Loading Envelopes

You can load up to 10 envelopes at a time, flap edge first and printable side up. Place 
the envelopes against the right edge of the sheet feeder, behind the tab. Press the 
locking tab on the left edge guide and slide it against the envelopes.

Before you print, make sure you choose the correct envelope size as the Paper Size 
setting. See page 12 (Windows) or page page 14 (Macintosh) for more information.

For best results, press each envelope flat before loading it, or load one envelope at a 
time.

Load with the 
printable side up
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Basic Printing in Windows

Here’s what to do to print a basic document—such as a newsletter or school project. 
Make sure you have paper in the printer, as described on page 8. After you create your 
document in a software program, follow these steps to print. 

1. From the File menu, click Print. You see a Print window (your window may look 
different):

2. Make sure EPSON Stylus C60 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next screen.)

Click here to open 
your printer 
software

Select your printer here
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You see your printer Properties (or Preferences) window.

The most important thing to remember is to set the correct Media Type for the 
paper you’re using. 

4. Make the following settings on the Properties (or Preferences) window:

� Choose the paper you’re printing on (click the 
arrow to scroll through the Media Type list). If 
you’re not sure which setting to select, see page 18. 

� Set the Ink option to Color to print a color 
document. To print a black text document, click 
Black.

� Set the Mode option to Automatic. It’s the easiest way to get good printing 
results on all types of paper.

� Set the slider in the Mode box to Quality or Speed to select high-quality 
printing, faster printing, or an in-between setting.

Select higher quality or faster 
printing

Select the type of paper you loaded

Select Automatic mode

Select the Ink color

Click OK



12 Printing From Start to Finish

5. Click the Paper tab at the top of the 
window if you need to change the 
paper size, number of copies, page 
orientation, or printable area.

6. Click the Layout tab if you want to 
reduce or enlarge your printed 
image, print multiple layouts, or add 
a watermark.

7. Click OK until you see the Print 
window again.

8. At the Print window, click OK 
(or Print) to start printing.

For more information about printer settings, click the Help button. Or 
right-click any item on the screen and then click What’s This?.

Click OK to start printing
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After a moment, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or restart printing. You can also see how much 
ink you have left. 

For more information on printing—for example, previewing your printout or adding 
a watermark—see your on-screen Reference Guide (as described on page 3). Click the 
EPSON Printer Information Center icon on your desktop.

When you’re finished using your printer, make sure you press the

 

P power button to turn it off. Never use a power strip or external switch 
to turn off the printer.

Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you usually 
print one type of document in different programs—for example, color photos on 
letter-size paper—you can change the default printer settings for all your programs. 

1. Right-click the  printer icon on your taskbar (in the lower right corner of your 
screen). 

2. Select Printer Settings. You see your printer Properties window, as shown on 
page 11.

3. Select the default settings you want to use for all your applications. Click OK 
when you’re finished.

Remember that you can always change the settings in your program when you want to 
print different types of documents.

Click to cancel printing

Click to pause or resume printing
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Basic Printing on a Macintosh

Here’s what to do to print a basic document—such as a newsletter or school project. 
Make sure you have paper in the printer, as described on page 8. After you create your 
document, follow these steps to print. 

1. From the File menu, select Page Setup. You see the following:

2. Make sure C60 Series is selected. 

If not, you need to select your printer in the Chooser.

3. Select the correct Paper Size, Orientation, and other settings. Then click OK.

4. From the File menu, select Print. You see a window like the following:

For more information about printer settings, click the ? button.

Make sure you see 
C60 Series

Select your paper size

Select the orientation 
of your document

Select higher quality or faster printing

Select the type of 
paper you loaded

Select Automatic mode

Select the 
Ink color



Printing From Start to Finish 15

5. Make the following settings:

� Choose the paper you’re printing on (click the arrow to scroll through the 
Media Type list). If you’re not sure which setting to select, see page 18. 

� Set the Ink option to Color to print a color document. To print a black text 
document, click Black.

� Set the Mode option to Automatic. It’s the easiest way to get good printing 
results on all types of paper.

� Set the slider in the Mode box to Quality or Speed to select high-quality 
printing, faster printing, or an in-between setting.

6. You can also do the following:

� Click  to reduce or enlarge your image, print multiple layouts, or add a 
watermark.

� Click  to turn on background printing. 

� Click  to change the Print button to Preview. You can then click it to 
preview your printout.

� Click  to check your ink levels. If the red 

 

b light is on or flashing, check to 
see if one of your ink cartridges is low or empty.

7. Click Print to start printing. If you turned on background printing, you see the 
EPSON Monitor3 window as shown:

If you’re not using background printing and you need to cancel printing, 
hold down the 

 

J key and press the . (period) key.

Select your print job, then click here to cancel printing Click to check ink levels
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For more information on printing—for example, printing posters or adding a 
watermark—see your on-screen Reference Guide (as described on page 3).

When you’re finished using your printer, make sure you press the

 

P power button to turn it off. Never use a power strip or external switch 
to turn off the printer.

Customizing Your Print Settings

You can use custom settings for draft printing, color matching, printing at higher 
resolutions, or selecting a variety of special effects. 

1. On the Properties or Preferences window (or the Print window on a Macintosh), 
click Custom, then click the Custom Settings list to open it. 

2. Select one of these settings:

� Text/Graph: For printing graphics-intensive documents, like presentations 
with charts and graphs.

� Economy: For printing rough drafts of text on plain paper. Saves ink. 

Click Custom, then…
choose from the Custom 
Settings list or…
click Advanced.
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� ICM (Image Color Matching; Windows only): For matching colors as closely 
as possible with ICM-compatible monitors or scanners. 

� sRGB (standard Red Green Blue; Windows only): For color matching with 
other sRGB devices, or for images designed for the Web. See your 
Windows help for details.

� ColorSync® (Macintosh only): For matching colors to your screen as closely as 
possible, when used with ColorSync-compatible devices and applications. 

3. To access advanced settings, click Custom and then click the Advanced button.

4. For higher quality printing (higher resolution), select Photo - 1440dpi or 
Photo - 2880dpi (if available for your paper type). Then click OK.

After you customize your print settings, you can save them as a group so you can 
reuse them whenever you print a similar project.

Printing is slower at higher resolutions.

For more information about advanced settings, click the Help or ? button or see your 
on-screen Reference Guide (as described on page 3).

Select color 
management settings

Select higher quality 
(higher resolution)

Set individual 
color values

Click to save settings
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Selecting the Correct Media Type

Your printer automatically adjusts itself for the type of 
paper you select in your print settings. That’s why the 
Media Type setting is so important. It tells your printer 
what kind of paper you’re using and adjusts the ink 
coverage accordingly. 

Here are the settings you should choose for your paper:

The availability of paper types varies by location.

For this paper . . . Select this Media Type setting . . .

Plain paper sheets or envelopes

EPSON Premium Bright White Paper

Plain paper

EPSON 360 dpi Ink Jet Paper

EPSON Iron-On Cool Peel Transfer Paper

360 dpi Ink Jet Paper

EPSON High Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Photo Paper

EPSON Photo Quality Glossy Paper

EPSON Glossy Photo Greeting Cards

Photo Paper

EPSON Premium Glossy Photo Paper 

EPSON Premium Semigloss Photo Paper

Premium Glossy Photo Paper

EPSON Photo Stickers®

EPSON Photo Quality Glossy Film

Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies

EPSON Matte Paper - Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper - Heavyweight
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Printing Photos

You can use special EPSON papers to print photographs that look almost as good as 
the ones you get from film processing. 

Following are some of the ways to get photos you can print:

� When you have your pictures developed, get them on a disk or CD-ROM.

� Import photos from a scanner or digital camera.

� Download photos from e-mail or from the Web. (Right-click a photo on the Web 
and save it as a file on your computer.)

Loading Paper

1. Place your paper against the right edge of the sheet feeder, behind the tab.

2. Press in the locking tab on the left edge guide and slide it against the paper. 

3. Pull out the output tray extension.

Always load paper short edge first, even when you’re printing landscape-oriented 
pictures.

See your Print Show movies for instructions on loading special types of paper, such as 
4 × 6-inch Photo Paper or Panoramic Photo Paper. Double-click the EPSON Printer 
Information Center icon on your desktop. 

Make sure the printable 
(whiter or glossier) side 
of the paper is face up
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� Load plain paper or EPSON Photo Quality Ink Jet Paper up to the arrow mark 
inside the left edge.

� Load up to 30 EPSON Photo Quality Ink Jet Cards or Glossy Photo Greeting 
Cards 

� Load up to 20 sheets of EPSON 4 × 6-inch Photo Paper or Matte Paper - 
Heavyweight.

� Load EPSON Premium Glossy Photo Paper, Double-Sided Matte Paper, Photo 
Stickers, and other special papers one sheet at a time.

If any paper you buy comes with a cleaning sheet, don’t use the cleaning 
sheet with this printer; it may cause a paper jam.

The following sections tell you how to print photos using Film Factory. You follow 
similar steps to print with other programs. 

Opening Your Photos in Film Factory

1. Start Film Factory. You see the main Film Factory screen:
 

If you need assistance with Film Factory, select Help Topics from the Help 
menu (Windows) or click the Help button (Macintosh).

Click a button for 
the type of print 
you want
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2. Click a button to pick one of the Print Options listed on the 
left side of the screen. 

For example, click the Standard Prints button. You see buttons 
for each step you need to follow, as shown.

3. Select a “roll of film” or click the New Roll button to create a 
new one. This lets you choose from photos you have already 
stored in Film Factory, or create a place to store new photos.

4. After you select or create your roll, click the Next Step button. 

5. Select your photo, or click Import and Retouch to import it. If 
you need to import your photo, do one of the following:

� Click From File to import a photo from your computer, a disk, or a 
CD-ROM. Locate the file, then click Move or Copy to bring it into Film 
Factory.

� Click Twain Device to import a photo from a scanner or digital camera. If 
your device is already selected, the software will open. If not, select Import 
Photo from the File menu, then select Import Settings.

6. Retouch or edit your photo as necessary. 

7. Continue with the steps in the next section to set up your print job.



22 Printing From Start to Finish

Setting Up Your Print Job

1. When you’re ready to print 
your photo, click Next Step, 
or click the Print 
Assignment button. You see 
the Print Assignment 
window:

2. Select the size photo you 
want to print, or click Fit to 
Media Size if you want the 
photo to fill the whole page. 

3. In the Height/Width Ratio 
box, select the ratio of your 
photo file, or select Trim to 
Fit Print Size.

Similar to traditional photo finishing, Film Factory may trim the edges of your 
image. This is because your image’s width/height proportions (or aspect ratio) 
may not match the proportions of the size you have selected. 

4. Select any of the Print Preferences you want. If you’re printing on 4 × 6-inch 
Photo Paper with perforations, click Micro-perf Paper.

5. Select the right Printer Settings for the paper you’re using. First, make sure 
EPSON Stylus C60 Series is selected.

6. Select the Media Size for the paper you’re using. 

If you’re using 4 × 6-inch Photo Paper, select Photo Paper 4 x 6 in (if your paper 
has perforations) or Photo Paper 4 x 6 in No Perforations.

Make sure your printer is selected

Select the size paper 
you’re using

Select the type of 
paper you’re using
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7. Select the Media Type for the paper you’re using. If you’re not sure which one to 
choose, see page 18.

8. Click Portrait or Landscape to select the orientation of your picture. 

9. If you’re using Windows, continue with the steps in the next section. If you’re 
using a Macintosh, skip to step 4 on page 24.

Printing Your Photos

1. Click the Properties button. You see your printer Properties (or Preferences) 
window.

.

2. Select PhotoEnhance if you want to improve the contrast, saturation, and color 
balance of your photo.

� Select Digital Camera Correction to eliminate common problems in digital 
camera photos.

� For more fine-tuning, select from a list of specialized settings for photographs, 
such as People or Nature, or select special filters, such as Soft Focus or a Sepia 
(brown) tint. 

Select to correct the 
exposure automatically

Select to improve 
digital camera photos
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PhotoEnhance does not change your original image; it only affects your 
printout. You may want to experiment to see which settings work best for 
your photos.

3. Click OK. You return to the Print Assignments screen.

4. Click Next Step. You see additional printing options:

5. Check the preview of your photo. If it doesn’t look the way you want, click Back 
and change your settings.

6. Select the number of copies you want. 

7. Click the Print icon. 

� If you’re using Windows, your pictures are printed.

� If you’re using a Macintosh, you see your Print window. Follow step 2 on 
page 23, then click Print. 

Store your prints in a resealable plastic bag, photo album, or glass-covered picture 
frames. Keep your pictures and unused paper away from high temperatures and 
humidity and out of direct sunlight. Make sure you return unused paper to its original 
package.

When you’re finished using your printer, make sure you press the

 

P power button to turn it off. Never use a power strip or external switch 
to turn off the printer.

Select the 
number of copies 
you want to print 

Click the Print icon
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Maintaining Your Printer

This chapter describes maintenance procedures to keep your printer working at its 
best, and preparation steps for moving your printer. Follow the instructions here for: 

� Cleaning the Print Head below

� Replacing an Ink Cartridge on page 27

� Aligning the Print Head on page 32

� Cleaning the Printer on page 33

� Transporting the Printer on page 34

For more details, watch your EPSON Print Show movies or read your on-screen 
Reference Guide. Click the EPSON Printer Information Center icon on your desktop.

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing from the image, 
you may need to clean the print head. This unclogs the nozzles so they can deliver ink 
properly. 

Print head cleaning uses ink, so clean it only if quality declines. 

This section explains how to clean the print head using the Head Cleaning utility. 
This is the recommended method when the printer is connected directly to your 
computer (not over a network). 

You can also clean the print head by holding down the 

 

b maintenance button on the 
printer for three seconds (when the red 

 

b error light is off). See your EPSON Print 
Show movies or on-screen Reference Guide for detailed instructions. 
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When you don’t turn on your printer for a long time, the print quality can 
decline. It’s a good idea to turn on your printer at least once a month to 
maintain good print quality.

Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red 

 

b error light is 
off. (If the red light is flashing or on, you may need to replace the ink cartridge; 
see page 27 for details.)

2. Do one of the following:

� Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

� Macintosh: Open the File menu and choose Page Setup or Print. Click the 
 Utility button, then click the  Head Cleaning button.

3. Follow the instructions on the screen to clean the print head. Cleaning takes 
about 30 seconds, during which the printer makes some noise and the green 

 

P power light flashes. 

Never turn off the printer while the 

 

P power light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.

4. When the green 

 

P power light stops flashing, run a nozzle check to confirm the 
print head nozzles are clean.

Make sure plain paper is loaded in the printer and click Print Nozzle Check 
Pattern. Then click Print. The nozzle check pattern prints (see the next section for 
details). 

5. If the nozzle check pattern has no gaps or lines, click Finish.

If the pattern has white lines, click Clean to clean the print head again. 

If you don’t see any improvement after cleaning three or four times, check the 
solutions beginning on page 41. You can also turn the printer off and wait 
overnight—this allows any dried ink to soften—and then try cleaning the print 
head again. 



Maintaining Your Printer 27

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. 
Each colored square should be solid, with no 
gaps or lines, as shown:

� If your printout looks okay, you’re done. 

� If you see any white lines or gaps (as shown), 
clean the print head again; see page 26 for 
instructions. 

Replacing an Ink Cartridge

When the red 

 

b error light flashes, an ink cartridge is low on ink. This is a good time 
to make sure you have a new cartridge. When the red 

 

b light stays on, you may need 
to replace one of the cartridges.

The red 

 

b error light also comes on if 
your paper runs out or is jammed, so 
make sure you check your paper before 
replacing a cartridge. 

To check your ink supply, do one of the 
following:

� Windows: Double-click the  printer icon 
on your taskbar (in the lower right corner of 
your screen). If one of your cartridges is low, 
you’ll see a window like the one on the right: 

� Windows: You can also double-click the  Ink Monitor icon. You see a window 
showing the amount of ink remaining. You can click the Buy Now button to 
launch your web browser and order ink cartridges online.
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� Macintosh: Open the File menu and choose Print. Click 
the  ink icon. You see a window like the one on the 
right:

When a cartridge is more than six months old, you may need 
to replace it if printouts don’t look their best. If the quality 
doesn’t improve after cleaning and aligning the print head, 
you can replace the cartridge even if the 

 

b error light is off. 

Use these EPSON ink cartridges within six months of 
installing them and before the expiration date on the package:

� Black ink cartridge: T028201

� Color ink cartridge: T029201 

Look for ink cartridge packages labelled T028 (black) or T029 (color).

To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered 
by EPSON’s warranty.

When you need new ink cartridges, contact your dealer or call EPSON at 
(800) 873-7766 or visit the EPSON StoreSM at www.epsonstore.com (U.S. sales 
only). In Canada, please call (800) 873-7766 for dealer referral. 

Ink Cartridge Precautions

Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If 
ink gets in your eyes, flush them thoroughly with water.

To avoid damaging the printer, never move the print head by hand.

You cannot print if either ink cartridge is empty. Leave the empty cartridge 
installed in the printer until you have obtained a replacement. Otherwise 
the ink remaining in the print head nozzles may dry out.
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Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start the ink 
cartridge replacement procedure, you must complete all the steps in one session. 

1. Make sure the printer is turned on and not printing (the green 

 

P power light 
should be on, but not flashing). Then open the printer cover.

2. Press the 

 

e ink replacement button. The 
print head moves to the center and the 
green 

 

P power light flashes.

The red 

 

b error light also begins to flash 
or remains on. 

� If it flashes at the same speed as the 
green 

 

P power light, you need to 
replace the black cartridge. 

� If it flashes twice as fast as the green 

 

P power light, you need to replace the 
color cartridge. 

� If it remains on, you need to replace 
both cartridges.

The color cartridge is on the right and the 
black is on the left. 

3. Pull up the ink cartridge clamp. The 
cartridge rises up from its holder.
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4. Lift the cartridge out of the printer and 
dispose of it carefully.

5. Unwrap the new ink cartridge. Then 
remove only the yellow tape seal on top. 

6. Tilt the new cartridge toward you 
slightly as you insert it. Lower the 
cartridge so that the tabs rest on the 
hooks. 

Don’t place the cartridge 
tabs under the hooks; you may 
damage the clamp when you close it. 

black cartridge color cartridge

You must remove the yellow tape from 
the top of the cartridge or you will 
permanently damage it. Don’t try to 
remove the clear seal underneath the 
cartridge.

Don’t touch the green circuit board on 
the back of the cartridge; you may 
inhibit normal operation and printing. 

hooks
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7. Press down firmly on the ink cartridge 
clamp until it snaps in place.

8. If you need to replace the other ink 
cartridge, repeat steps 3 through 7 before 
continuing with step 9.

9. Press the 

 

e ink replacement button and 
close the printer cover. The printer begins 
charging the ink delivery system.

The green 

 

P power light flashes and the 
printer makes noise. Charging takes about 
half a minute. When it’s finished, the green 

 

P power light stops flashing and stays on, 
and the red 

 

b error light goes out.

Never turn off the printer while the 
green 

 

P power light is flashing, unless the printer hasn’t moved or 
made noise for more than 5 minutes.
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Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to align the print 
head. Your printer must be connected directly to your computer (not over a network) 
to use the Print Head Alignment utility. 

Load plain paper that’s at least 8.27 inches (210 mm) wide to prevent 
ink from spraying inside the printer and smudging your printouts. 

1. Make sure the printer is turned on, but not printing, and letter-size plain paper is 
loaded.

2. Do one of the following:

� Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen) and select Print Head Alignment.

� Macintosh: Open the File menu and choose Page Setup or Print. Then click 
the  Utility button. In the Utility menu, click the  Print Head 
Alignment button.

3. Follow the instructions on the screen to 
print a test page. You see this window:

4. On the printed page, select the pattern 
that shows the two vertical lines most 
precisely printed on top of each other. 
You may need to use a magnifying glass.

Select one pattern each for rows 1, 2, and 
3. Then enter the number of the best 
pattern for each row in the 
corresponding boxes on the screen.

5. Click Realignment to print another test page. Make sure the pattern numbered 8 
in each row is the best aligned. If not, repeat steps 4 and 5.

6. When you’re finished, click Finish. 
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Cleaning the Printer 

To keep your printer working at its best, you should clean it several times a year. 

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.

2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet 
feeder.

3. Clean the exterior of the printer with a soft, 
damp cloth. 

4. Clean ink out of the printer’s interior with a 
soft, damp cloth.

Don’t touch the gears inside the 
printer.

Be careful not to wipe the carriage shaft

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; 
they can damage the printer components and case. 

Don’t get water on the printer components and don’t spray lubricants or 
oils inside the printer. 

Don’t use any cleaning sheets included with special paper; they may 
jam inside the printer.

Clean 
here

Don’t touch the carriage shaft
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Transporting the Printer 

If you move your printer some distance, you need to prepare it for transportation in 
its original box or one of a similar size. 

To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

Be sure to remove the tape used in step 4 after installing the printer in its 
new location.

1. Turn on the printer, wait until the print head locks in the far right position, then 
turn off the printer.

2. Unplug the power cord from the electrical outlet. Then disconnect the printer 
cable from the printer.

3. Remove any paper from the printer and remove the paper support.

4. Open the printer cover. Secure the ink cartridge 
holder to the printer with tape as shown, then 
close the printer cover.

5. Push in the output tray extension and close the 
tray.

6. Repack the printer and its attachments in the 
original box using the protective materials that 
came with them. See your Start Here sheet.

Keep the printer level as you transport it. 

After transporting the printer, remove the tape securing the print head and test your 
printer. If you notice a decline in print quality, clean the print head (see page 25); if 
output is misaligned, align the print head (see page 32). 

Tape the ink cartridge 
holder to the printer case
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Solving Problems

This section gives you the basics for diagnosing and solving printer problems. 

First see “Diagnosing Printer Problems” on page 37 to help determine what the cause 
of the problem may be. Refer to the pictures on page 36 if you need help identifying 
parts of the printer.

It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

Then see these sections for solutions:

� Setup and Software Installation Problems on page 39

� Printer Problems on page 40

� Print Quality Problems on page 41

� Paper Feeding Problems on page 44

� Miscellaneous Printout Problems on page 45

� Uninstalling and Reinstalling Printer Software on page 46

� Where to Get Help on page 47
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Printer Parts

power button 
and light

maintenance button 
and error light

ink replacement button

paper support

printer cover

output tray extension

output tray

left edge guide

ink cartridges and 
print head
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Diagnosing Printer Problems

First, check the printer’s lights as described below, or run a printer check as described 
on page 38.

Lights Explanation

Green 

 

P power light 
flashes

The printer is receiving a print job, replacing an ink cartridge, 
charging ink, or cleaning the print head.

Red 

 

b error light is 
on

Your paper ran out, ink ran out, or paper is jammed. You may also 
see a message on your screen.

� If paper is out, load more paper, then press the 

 

b maintenance button to resume printing. 

� If paper is jammed, press the 

 

b maintenance button 
to eject the paper. If that doesn’t work, turn off the printer, 
open the cover, and pull the paper out from the front, including 
any torn pieces. Then turn on the printer, reload paper, and 
press the 

 

b maintenance button.

� If you see an ink out message on your screen, you need to 
replace one of your ink cartridges. Replace the cartridge as 
described on page 27.

Red 

 

b error light 
flashes

One of the ink cartridges is low. Make sure you have a replacement 
cartridge. To determine which cartridge is low, check the ink level 
as described on pages 27 and 28.

Green 

 

P power 
light is off and red 

 

b error light is on

Paper may be blocking movement of the print head. Turn off the 
printer, open the cover, and remove any jammed paper or other 
foreign objects. Then turn the printer on again. If the lights are still 
on, contact your dealer or EPSON; see page 47 for contact 
information.

Green 

 

P power light 
and red 

 

b error

 

 light

 

 
flash 

The printer may have an internal error. Turn off the printer, wait a 
few seconds, and turn it on again. If the lights are still flashing, 
contact your dealer or EPSON; see page 47 for contact information.

Green 

 

P power light 
and red 

 

b error

 

 light 
are on after installing 
an ink cartridge

One of your ink cartridges is installed incorrectly. Follow the 
instructions on pages 29 to 31 to remove and reinstall the 
cartridges.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
itself or some other source. The printer check also shows how much black and color 
ink you have left.

1. Make sure both the printer and computer are turned off. Then disconnect the 
interface cable from the printer.

2. Make sure letter-size or larger plain paper is loaded in the printer.

3. Hold down the 

 

b

 

 maintenance 
button, then press and release the 

 

Ppower button. Continue holding 
down the 

 

b

 

 maintenance button until 
the green 

 

P power light starts to flash, 
then release it.

The printer prints one page showing its 
ROM version number, black and color ink 
percentages remaining, and a nozzle check 
pattern. (If the pattern has lines, you need 
to clean the print head; see page 25.)

4. Turn off the printer after it prints the 
check page. Then reconnect the cable and turn on your printer and computer.

� If the check page prints, the problem probably lies in your software settings, 
the interface cable, or your computer. Your software may not be installed 
correctly.

� If the check page doesn’t print, you may have a problem with your printer. 
Try the suggestions in “Problems and Solutions” beginning on page 39. If 
nothing works, contact your dealer or EPSON as described on page 47.
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Problems and Solutions

Setup and Software 
Installation Problems

The printer makes noise after ink 
cartridge installation.

� The first time you install ink 
cartridges, the printer must charge 
its print head for a few minutes. 
Wait until charging finishes (the 
green 

 

P power light stops flashing) 
before you turn off the printer, or it 
may charge improperly and use 
excess ink the next time you turn it 
on. 

If the printer stops moving or 
making noise, but the green 

 

P power light is still flashing after 5 
minutes, turn off the printer. If the 
light is still flashing when you turn it 
back on, contact EPSON as 
described on page 47.

� Make sure the ink cartridge clamps 
are locked down completely and no 
packing material remains in the 
printer. Turn off the printer, wait a 
moment, then turn it back on to 
clear the error.

You’re having problems installing the 
printer software.

� Make sure your printer is turned on 
and the printer cable is securely 
connected at both ends. Then 
carefully follow the installation 
instructions on the Start Here sheet. 
Also make sure your system meets 
the requirements on pages 49 
and 50.

� Close your other programs, 
including any screen savers and virus 
protection software, and install 
again.

� If your printer icon (C60 Series) 
doesn’t appear in the Macintosh 
Chooser, you may have too many 
items in the Chooser. Delete any 
unused items and check the Chooser 
again.

� For Windows 2000, if you see an 
error message or your software 
doesn’t install correctly, you may not 
have software installation privileges. 
Contact your System Administrator.



40 Solving Problems

� In Windows 2000 or XP, don’t 
select Block under Control Panel> 
System> Hardware> Driver Signing; 
select Ignore or Warn instead.

� If you’re using Windows 98, Me, 
2000, or XP, make sure your system 
was not upgraded from Windows 
95. The USB Printer Device Driver 
may not install correctly if you 
upgraded from Windows 95.

� Make sure the USB Controller is 
working properly in Device 
Manager. See your Windows help 
system for details. If it’s not 
working, contact your computer 
manufacturer.

� If you’re printing over a network, see 
your on-screen Reference Guide for 
instructions on configuring your 
printer for use on a network.

Printer Problems

Only the

 

 green 

 

P power light is on, 
but nothing prints.

� Make sure the interface cable is 
connected securely and that the cable 
meets the system requirements on 
pages 49 and 50.

� Run a printer check as described on 
page 38. If the check page prints, 
make sure your software is installed 
correctly. 

� If you’re printing on a network, you 
need to set up your printer for 
network printing, as described in 
your on-screen Reference Guide.

The printer sounds as though it is 
printing, but nothing prints.

� Make sure the print head nozzles are 
not clogged. To clean the print head, 
see page 25.

� The printer won’t operate properly if 
it’s tilted or at an angle. Place it on a 
flat, stable surface that extends 
beyond the printer base in all 
directions.
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Your printer makes noise when you 
turn it on or after it has been sitting 
for a while.

Your printer is performing routine 
maintenance.

Printing is too slow.

Make sure your system meets the 
requirements listed on pages 49 and 50. 
If you’re printing a high-resolution 
image, you need more than the 
minimum requirements listed. You may 
also need to:

� Clear space on your hard drive or 
run a defragmentation utility.

� Close programs that you’re not 
using.

� Increase your system’s memory.

For the fastest printing, try these tips:

� Choose Black ink if your document 
doesn’t include color.

� Set the Quality/Speed slider to 
Speed.

� In the Advanced window, turn 
MicroWeave® off and/or turn High 
Speed on.

� If your printer is connected to a hub, 
disconnect unused USB devices.

� If you’re using the parallel port, 
enable ECP/DMA mode on your 
computer’s parallel port. See your 
computer documentation or the 
manufacturer for instructions.

Print Quality Problems

You see banding (light lines).

� The print head nozzles may need 
cleaning; see page 25 for 
instructions. 

� Make sure the Media Type setting 
matches the paper you loaded; see 
page 18 for guidelines.

� Make sure the printable side of the 
paper is face up. It’s usually whiter 
or shinier.

� The ink cartridges may need 
replacing. To replace an ink 
cartridge, see page 27.

� Try using Automatic mode. See 
page 11 (Windows) or page 14 
(Macintosh) for instructions.

� Run the Print Head Alignment 
utility; see page 32 for instructions.
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Your printout is blurry or smeared.

� Make sure your paper isn’t damp or 
curled, or loaded face down (the 
printable side should be face up). If 
it’s damp or curled, reload a new 
stack of paper.

� Use a support sheet with special 
paper, or try loading your paper one 
sheet at a time.

� Make sure your paper meets the 
specifications listed in the on-screen 
Reference Guide. 

� Use EPSON papers to ensure proper 
saturation and absorption of genuine 
EPSON inks. 

� Run the Print Head Alignment 
utility. See page 32 for instructions.

Your printout is faint or has gaps.

� The print head nozzles may need 
cleaning; see page 25 for 
instructions. 

� The ink cartridges may be old or low 
on ink. To replace an ink cartridge, 
see page 27. 

� Make sure the Media Type setting 
matches the paper you loaded. See 
page 18 for guidelines.

� Make sure your paper isn’t damaged, 
old, dirty, or loaded face down. If it 
is, reload a new stack of paper with 
the printable side up; it is usually 
whiter or shinier than the other side.



Solving Problems 43

You see wrong or missing colors.

� Make sure the Ink option is set to 
Color for color images and your 
software is set for color printing.

� The print head nozzles may need 
cleaning; see page 25 for 
instructions.

� The ink cartridges may be old or low 
on ink. To replace an ink cartridge, 
see page 27.

� Try turning off PhotoEnhance. Also 
check if you’re using a special effect 
that alters image colors, like Sepia. 

� Try using Automatic mode. See 
page 11 (Windows) or page 14 
(Macintosh) for instructions.

� Try changing the Gamma setting in 
the Advanced window; see page 17 
for information about Advanced 
settings.

� Your printed colors can never exactly 
match your on-screen colors. 
However, you can use a color 
management system to get as close as 
possible. Try using the ICM 
(Windows) or ColorSync 
(Macintosh) setting. 

Your printout is grainy.

� Try using a higher quality paper.

� Select a higher Print Quality 
(resolution) setting. See page 17 for 
instructions.

� Run the Print Head Alignment 
utility. See page 32 for instructions.

� You may need to increase the 
image resolution or print it in a 
smaller size; see your software 
documentation.
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Paper Feeding Problems

Too many copies are printing.

Make sure that the Copies option in 
your printer software or program is not 
set for multiple copies.

Paper doesn’t eject fully or is 
wrinkled.

� If the paper doesn’t eject fully, you 
may have set the wrong paper size. 
Press the 

 

b

 

 maintenance button to 
eject the paper, and then select the 
correct paper size.

� If it’s wrinkled when it ejects, the 
paper may be damp or too thin.

Paper doesn’t feed correctly or jams in 
the printer.

� If paper doesn’t feed, remove it from 
the sheet feeder. Reload it against 
the right edge, behind the tabs, then 
slide the left edge guide against the 
paper.

� If multiple pages feed at once, 
remove the paper from the sheet 
feeder, fan the edges to separate the 
sheets, then reload it.

� If paper jams, press the 

 

b maintenance button for 
several seconds to clear the jam. If 
that doesn’t work, open the cover 
and pull the paper out from the 
front, including small pieces that 
may have torn off. Reload the paper 
and press the 

 

b maintenance 
button.

If your paper loads incorrectly or jams 
frequently:

� Use new, smooth, high-quality 
paper, loaded printable side up.

� Fan the edges of the stack of paper to 
separate the sheets.

� Don’t load paper above the arrow 
mark inside the left edge guide.

� Place the paper against the right edge 
behind the tabs. Slide the left edge 
guide against it, but not too tightly. 
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Miscellaneous Printout 
Problems

The image is inverted, as if viewed in a 
mirror.

Turn off Flip Horizontal in the Advanced 
window or the mirror setting in your 
program. (If you’re printing on EPSON 
Iron-On Cool Peel Transfer Paper, the 
image should be inverted.)

The printer prints blank pages.

� Make sure your printer is selected in 
Windows, or is the active printer in 
the Macintosh Chooser.

� The print head nozzles may need 
cleaning. See page 25. 

Image size or position is incorrect.

Make sure paper and layout options are 
set correctly.

The margins are incorrect.

� Make sure the paper settings are 
correct for your paper size. See 
page 12 (Windows) or page 14 
(Macintosh) for instructions.

� See your software documentation for 
instructions on choosing the correct 
margins for your paper size. The 
margins must be within the 
printable area of the page. See 
“Printer Specifications” in your 
on-screen Reference Guide.

� Make sure your paper is positioned 
next to the right side of the feeder.

You see incorrect characters.

� Make sure the interface cable is 
securely connected and meets the 
system requirements on page 49 or 
page 50. Then try printing again.

� Make sure your printer is selected in 
your software, or is set as the active 
printer in the Macintosh Chooser. 

� If you’re using a switch box or USB 
hub with your printer, connect the 
printer directly to your computer.
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Uninstalling and Reinstalling Printer 
Software 

You may need to uninstall and then reinstall your printer driver and utilities. For 
example, this might be necessary when you upgrade your Windows operating system. 
You don’t need to uninstall Film Factory or your EPSON Print Show movies and 
Reference Guide. 

Windows

1. Click Start, and select Programs or All Programs.

2. Point to Epson or EPSON Printers, then select EPSON Printer Software Uninstall.

3. In the next window, make sure EPSON Stylus C60 Series is selected and click OK. 
Then follow the on-screen instructions. 

4. Restart your computer when you’re done, then follow the instructions on the 
Start Here sheet to reinstall your software. 

Macintosh

1. Insert your printer software CD-ROM. 

2. Double-click the EPSON CD-ROM icon (if necessary) and double-click the
 EPSON icon. The Main Menu appears.

3. Click Install Printer Driver. On the installer screen click the arrow in the Easy 
Install list at the top and select Uninstall. Then click the Uninstall button at the 
bottom and follow the instructions.

4. Restart your Macintosh, then follow the instructions on the Start Here sheet to 
reinstall your software.
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Where To Get Help

If you need help with your printer or Film Factory, see the contact information 
below. If you need help using other software with your printer, see the documentation 
for that software for technical support information. 

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed below:

You can purchase ink cartridges, paper, manuals, and accessories from EPSON at 
(800) 873-7766, or visit the EPSON Store at www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 873-7766 for dealer referral.

Service Access

World Wide 
Web

From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download drivers 
and other files, look at product documentation, access 
troubleshooting information, and receive technical advice through 
e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, 
seven days a week. To use these services, you must have a touch 
tone telephone and call (800) 922-8911. Your SoundAdviceSM 
Express Code is 70680. Use this code to quickly select the EPSON 
Stylus C60 in SoundAdvice.
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Requirements and Notices

This chapter includes system requirements, safety instructions, legal notices, and other important 
information.

Windows System Requirements

To use your printer and its software, your system should have: 

� A Microsoft Windows compatible PC with a Pentium® or better processor (for Windows 98 or 
95), Pentium 150 MHz or better (for Windows Me), or Pentium 133 MHz or better (for 
Windows 2000 or XP) 

� Microsoft Windows 95, Windows 98, Windows Me, Windows 2000, or Windows XP

� At least 20MB of RAM (for Windows 98 or 95), 32MB (for Windows Me), or 
64MB (for Windows 2000 or XP)

� 50MB of free hard disk space (100MB or more recommended)

� VGA or better display adapter and monitor

� CD-ROM or DVD drive for installing the printer software

� One of the following:

For parallel connection: a high-speed, bidirectional, IEEE-1284 compliant parallel cable (6 to 10 
feet long) with a D-SUB, 21-pin, male connector for your computer and a 36-pin Centronics® 
compatible connector for the printer

For USB connection: a computer running Windows 98, Windows Me, Windows 2000, or 
Windows XP with a Windows-compliant USB port and a shielded USB “AB” cable up to 6.5 feet 
(2 meters) long.
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Macintosh System Requirements

To use your printer and its software, your system should have: 

� An Apple® iMac™ series or Power Macintosh® G3 or G4 with built-in USB port

� Mac® OS 8.5.1 through 9.1. (Mac OS 9.0 or later recommended)

Check EPSON’s web site for information about support for Mac OS X 
(http://support.epson.com).

� At least 16MB of available RAM (32MB recommended)

� At least 50MB of free hard disk space (100MB recommended)

� VGA display or better

� CD-ROM or DVD drive for installing the printer software

� A shielded USB “AB” cable up to 6.5 feet (2 meters) long.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy efficiency. The 
EPA ENERGY STAR office equipment program is a voluntary 
partnership with the computer and office equipment industry to 
promote the introduction of energy-efficient personal computers, 
monitors, printers, fax machines, and copiers in an effort to reduce air 
pollution caused by power generation.
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Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely 
and effectively:

� Be sure to follow all warnings and instructions marked on the printer.

� Use only the type of power source indicated on the printer’s label.

� Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

� Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.

� Do not let the power cord become damaged or frayed. 

� If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere 
rating.

� Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

� Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

� Leave enough room around the printer for sufficient ventilation.

� Do not place the printer near a radiator or heating vent or in direct sunlight.

� Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

� Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

Always turn the printer off using the 

 

P power button. Don’t switch off the power 
strip or unplug the printer until the green 

 

P power light is off.

� Do not block or cover the openings in the printer’s case or insert objects through the slots. 

� Except as specifically explained in this manual, do not attempt to service the printer yourself. 

� Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change 
in performance. Adjust only those controls that are covered by the operating instructions.
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Ink Cartridge Safety Instructions

� Keep ink cartridges out of the reach of children and do not drink the ink. 

� Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

� Do not put your hand inside the printer or touch the cartridge during printing.

� Do not move the print head by hand. You may damage the printer.

� Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge 
unpacked for a long time before use can result in reduced print quality.

� Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use 
up the ink cartridges within six months of first installing them.

� Store ink cartridges in a cool, dark place.

� After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

� Do not shake an ink cartridge; this can cause leakage.

� Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

� Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

� If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

� Before transporting the printer, make sure the print head is capped in the far right position and the 
ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains 
in the proper position.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

� Reorient or relocate the receiving antenna.

� Increase the separation between the equipment and receiver.

� Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

� Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which exceed the 
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly 
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON

Type of Product: Ink Jet Printer

Model: P320A

Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the first retail purchaser that the EPSON 
printer covered by this limited warranty statement, if purchased and used in the United States or 
Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship 
and materials for a period of one (1) year from the date of original purchase. Epson also warrants that 
the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified 
usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. 
For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your EPSON printer prove defective during the 
warranty period, please call the EPSON ConnectionSM at (562) 276-7525 (U.S.) or (905) 709-2567 
(Canada) for warranty instructions and return authorization. An Epson service technician will provide 
telephone diagnostic service to determine whether the printer requires service. If service is needed, 
Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson 
authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight 
prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 
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packaging the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement. Epson requires a debit or credit card number to secure the cost of the replacement printer 
in the event that you fail to return the defective one. If you choose not to give this information, the 
exchange printer will only be shipped to you after Epson receives the defective one. If your printer is 
being repaired, Epson will direct you to send your printer to Epson or its authorized service center, 
where the printer will be fixed and sent back to you. You are responsible for packing the printer and for 
all costs to and from the Epson authorized service center. When warranty service involves the exchange 
of the printer or a part, the item replaced becomes Epson property. The replacement printer or part 
may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another 
model of like kind and quality. Epson’s liability for replacement of the covered printer will not exceed 
the original retail selling price of the covered printer. Exchange products and parts assume the 
remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and 
Canada. This warranty is not transferable and will not apply to products purchased from an end user. 
This warranty does not cover any color change or fading of prints or reimbursement of materials or 
services required for reprinting. This warranty does not cover damage to the EPSON product caused 
by parts or supplies not manufactured, distributed, or certified by Epson. This warranty does not cover 
ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON 
product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not 
responsible for warranty service should the Epson label or logo or the rating label or serial number be 
removed or should the product fail to be properly maintained or fail to function properly as a result of 
misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as 
fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson 
products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be 
identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE 
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL 
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction. 

Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
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Index

Numerics

360 dpi Ink Jet Paper, 18
4 × 6-inch Photo Paper, 22

A

Accessories, 47
Advanced settings, 17
Aligning print head, 32
Animated tutorials, 3 to 5
Automatic mode

Macintosh, 14 to 15
Windows, 11

B

Background printing, 15
Banding, 41
Blank pages, 45
Blurry images, 42
Browser, 3
Buttons, 36

C

Cable, printer, 49 to 50
Cancelling printing

Macintosh, 15
Windows, 13

Characters, incorrect, 45
Checking printer, 38

Cleaning
print head, 25 to 27
printer, 33
sheets, 20, 33

Color problems, 43
ColorSync, 17
Controlling printing

Macintosh, 15
Windows, 13

Copies setting
Film Factory, 24
Macintosh, 14
Windows, 12

Custom settings, 16 to 17

D

Default settings, Windows, 13
Digital Camera Correction setting, 23
Documentation, 2 to 6

E

Economy setting, 16
Electronic manual, 3 to 6
Envelopes, 9
EPSON

accessories, 47
help, 47
papers, 18 to 20
Printer Information Center, 4
Store, 28, 47



58 Index

F

Faint images, 42
Film Factory, 20 to 24
Filters, 23
Flip Horizontal setting, 45

G

Glossy paper, 18 to 20
Grainy prints, 43

H

Head Cleaning utility, 25 to 26
Help, EPSON, 47
High Speed setting, 41
High-quality (resolution) images, 17

I

ICM (Image Color Matching) setting, 17
Incorrect characters, 45
Incorrect colors, 43
Ink cartridge

level of ink in, 13, 15, 27 to 28, 38
ordering, 27 to 28
replacing, 27 to 31
safety instructions, 28 to 30, 52

Ink Jet Transparencies, 18
Ink level, checking

Macintosh, 15, 28
Windows, 13, 27
without computer, 38

Ink Monitor, 27
Ink setting

Macintosh, 15
Windows, 11

Installation problems, 39 to 40
Inverted image, 45
Iron-On Cool Peel Transfer Paper, 18, 45

J

Jams, paper, 44

L

Layout problems, 45
Layout settings

Macintosh, 15
Windows, 12

Letterhead, 8
Lights, 36 to 37

M

Macintosh
printing with, 14 to 16
system requirements, 50
uninstalling software, 46

Maintaining printer, 25 to 33
Margins, incorrect, 45
Matte Paper - Heavyweight, 18 to 20
Media Type setting

Macintosh, 15, 18
Windows, 11, 18

MicroWeave setting, 41
Mirror images, 45
Monitoring ink level

Macintosh, 15, 28
Windows, 13, 27
without computer, 38

Moving printer, 34

N

Network printing, 40
Noise, printer, 41
Nozzle Check, 26 to 27
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P

Page Setup, Macintosh, 14
Paper

EPSON, 18 to 20
feeding problems, 44
loading, 8 to 9, 19 to 20
settings, 12, 14

Photo Paper, 18 to 20
Photo Quality Ink Jet Paper, 18
PhotoEnhance, 23
Photos, printing, 19 to 24
Premium Glossy Photo Paper, 18 to 20
Preprinted paper, 8
Previewing printout, 15
Print dialog box, 14
Print head

aligning, 32
cleaning, 25 to 27

Print Head Alignment utility, 32
Print quality problems, 41 to 43
Print Show movies, 3 to 5
Printer

cable, 49 to 50
check, 38
cleaning, 33
maintaining, 25 to 33
movies, 3 to 5
noise, 41
parts, 36
problems, 37 to 45
properties, 11
transporting, 34
turning off, 24

Printer Information Center, 4
Printing

advanced, 17
controlling, 13, 15
photos, 19 to 24
slow, 41
with custom settings, 16 to 17
with Macintosh, 14 to 16
with PhotoEnhance, 23
with Windows, 10 to 13

Problems
installing software, 39 to 40
miscellaneous, 45
paper feeding, 44
print quality, 41 to 43
printer, 40 to 41

Progress Meter, 13
Properties, printer, 11

Q

Quality/Speed setting, 11, 15

R

Reference Guide, 3 to 6

S

Safety instructions, 51 to 52
Self adhesive sheets, 18
Service, 47
Slow printing, 41
Software

problems, solving, 39 to 40
uninstalling, 46

SoundAdvice, 47
sRGB setting, 17
Support, 47
System requirements, 49 to 50

T

Technical support, 47
Text/Graph setting, 16
Transparencies, 18
Transporting printer, 34
Troubleshooting, 35 to 45
Tutorials, 3 to 5
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U

Uninstalling software, 46
USB

problems, 40
requirements, 49, 50

Utilities
Head Cleaning, 25 to 26
Nozzle Check, 27
Print Head Alignment, 32

W

Watermark, 12, 16
Windows

default settings, 13
printing with, 10 to 13
system requirements, 49
uninstalling software, 46

World Wide Web, 47
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